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 Evolution of Computers

OneOne LearnTouch

A.	 1. a.	 2. c.	 3. c.	 4. a.	 5. b.

B.	 1. F	 2. F	 3. F	 4. F

C.	 1. Charles Babbage	 2. Lady Ada Lovelace	 3. John Mauchly	 4. IBM	 5. ENIAC

ItLet's Do

A.	 1.	� The people used to calculate or count with the help of fingers, toes, pebbles, stones, sticks 
and bones in olden times. 

	 2.	 Fourth generation of computers used microprocessors. 
	 3.	 Charles Babbage invented Analytical Engine.
	 4.	 Computers have zero IQ and hence lack the decision making power.
B.	 1.	 First Generation Computers Second Generation Computers

a. � First generation computers were 
made up of vacuum tubes.

a. � Second generation computers were made 
up of transistors.

b. � They were huge in size and very 
expensive.

b. � They were small in size and less expensive 
than the first generation computers.

	 2.	 a.	� ENIAC was the first electronic general purpose digital computer built in 1945 by John 
Mauchly and Presper Eckert. It contained over 18,000 vacuum tubes and was 1000 times 
faster than Mark-I.

		  b. 	�Abacus is a wooden frame with beads on parallel wires which can do simple calculations 
like addition and subtraction. It was invented about 3000 years ago, in China to calculate 
numbers at a fast speed.

	 3.	 Features of fifth-generation computers are:
		  a.	 Use artificial intelligence.

1.
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		  b.	 Improved size, cost, speed and performance.
	 4.	 Any two characteristics of computers are:
		  a.	� Reliability: Computer does not make mistakes. If the input is correct, then the computer 

always gives the relevant answer to the input.
		  b.	 Power of remembering: The data stored in the computer can be recalled at any time.
C.	 1. �Because a computer does not have a brain like human beings. It cannot take a decision on its 

own. It can only perform the tasks that are instructed by the human being. 
2. Old Computer New Computer

It is slow and takes a long time to start. It is fast and efficient.
It is bulky and heavy. �It is slim and lightweight.
�It has an outdated operating system, which 
makes running modern applications difficult.

The latest operating system, makes it ideal 
for multitasking.

Higher Order Thinking Skills (HOTS) 
1.	 �A laptop is better than a desktop for this purpose because we can easily carry it anywhere, and 

it has a battery, which makes it convenient to use even when there is no electricity.
2.	 Do it yourself.

Crack CodeThe

A.	 1. Difference Engine and Analytical Engine 	 2. ENIAC and UNIVAC 

	 3. Pascaline 	 4. Tabulating machine 	 5. Step Reckoner  

B.	 1. 1642 	 	 2. 1945 	 	 3. 1833 	 	 4. 1985 

Do it yourself.

 Computer Software

OneOne LearnTouch

A.	 1. c.		  2. c.		  3. b.		  4. c.		  5. c.

B.	 1. T		  2. F		  3. F		  4. F

C.	 1. System software	2. Operating system	 3. Application software

	 4. Disk defragmenter	 5. Word processors

D.	 1. d	 2. c	 3. a	 4. e	 5. b
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ItLet's Do

A.	 1.	 An Operating system serves as an interface between the user and the hardware.

	 2.	 MS word, MS PowerPoint & Coral draw are the three general purpose software.
	 3.	� An Operational Support System (OSS) is a group of computer programs. It is used by 

Telecommunication Service Providers (TSP) for monitoring, controlling, analyzing and managing 
a computer or telephone network system.

B.	 1.	� System software is the most important software to operate a computer. System software 
can be classified into three categories: Operating System, Programming Software and Utility 
Software.

	 2.	� Programming software is the software used by the computer to understand and convert 
the instructions by programming language into machine language. Compilers, assemblers, 
debuggers, interpreters, etc. are examples of programming software.

	 	� An assembler is a program used to translate assembly language into machine language so 
that the computer can understand it. Whereas, an interpreter is a separate program that 
converts the entire source program into machine language before executing it. An interpreter 
translates and executes one statement at a time.

	 3.	�� It is a program designed to help users perform specific tasks. These tasks can be personal, 
educational, business-related, etc.  

		�  Backup utility software or backup software is a computer program that copies your files, 
folders, databases, or even your entire system for emergency. Windows Backup and Restore 
is the default Windows backup utility. 

	 4.	 System software Application software
a. � System software is used for operating 

computer hardware as well as software. 
a. � Application software is used by users 

to perform particular task.
b. � It can run independently with some 

conditions. 
b. � It cannot run without the presence of 

the system software. 

C.	 1.	� Multimedia software: These software are used to combine the text with graphics, videos, 
animations and sounds.

	 	 Word Processor: These software are used to create, edit, format and print text documents. 
	 2.	� Shikha’s father told her to install antivirus software to protect her computer from viruses and 

malware.

Higher Order Thinking Skills (HOTS) 

1.	 Do it yourself
2.	 �Without an operating system, the computer cannot run programs, connect to the Internet, or 

even show anything on the screen.
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Crack CodeThe

1. Word processor	 2. Anti-virus software	     3. Data compression program

Do it yourself.

 Advanced Features of Word 2016

OneOne LearnTouch

A.	 1. a.	 2. b.		  3. b.		  4. c.		  5. a.

B.	 1. F	 2. T		  3. T		  4. F		  5. T

C.	 1. Portrait			   2. Layout	 3. Subscript		  4. Footer

ItLet's Do

A.	 1.	 Footer is the text like page number that appears at the bottom of each page of the document.

	 2.	 Page margin is the white space all around the printed area of the paper.

	 3.	 Portrait & Landscape are the two types of page orientations in Word.

B.	 1.	� To substitute a word or phrase with another word or phrase, follow these steps:

		  Step 1	 Click on Home tab.

		  Step 2	� Click on the Replace command in the Editing group. This will open Find and Replace 
dialog box.

		  Step 3	 Type the existing word or phrase that is to be changed in the Find what text box.

		  Step 4	 Type the new word or phrase in the Replace with text box.

		  Step 5	� Click on Find Next and Replace buttons for selective replacement of the text or 
click on Replace All button to replace all occurrences of the existing text with the  
new text.

	 2.	� A column divides the text into two or more vertical sections in a document. Whereas a column 
break is used to shift text from one column to the next as needed.

	 3.	� Tabs move the cursor one-half inch by default. They work when we press the Tab key on the 
keyboard. The position where the cursor moves on pressing the Tab key is called Tab stop. 
If we place the cursor at the beginning of a paragraph and press Tab key, the first line of the 
paragraph gets indented by ½ inch.

3.
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C.	 1.	� Lily can use the Find and Replace feature to replace ‘cat’ to ‘dog’ in Word. There will be 5 
dogs after the replacement.

	 2. 	� Rohit can use the Orientation feature to do this. After changing the orientation from Portrait 
to Landscape the document will have the longer edge at the top.

Higher Order Thinking Skills (HOTS) 

	 1.	 You can use the Format Painter command to copy the style and apply it in other sub-headings.

	 2. 	 To do this he can use the Subscript command from the Font group.

Crack CodeThe

A.	 1. Text		  2. Home		  3. Text Effect, Font
	 4. Shadow		 5. Shadow Effect.
B.	 T
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Do it yourself.

 Graphics in Word 2016

OneOne LearnTouch

A.	 1. b.		  2. a.		  3. c.		  4. c.	 5. a.

B.	 1. Shapes		  2. Insert		 3. WordArt	 4. 3-D

C.	 1. Shapes		  2. WordArt	 3. Picture	 4. Symbol

4.
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ItLet's Do

A.	 1.	 Bevel is one of the shape effects that adds thickness and rounded edges to shapes.

	 2.	� Word 2016 comes with a set of readymade shapes that we can use in our document. We can 
resize, rotate, flip, colour, and combine the shapes with other shapes to make more complex 
shapes in Word.

	 3.	 Symbols are punctuations or special characters generally not found on the keyboard.

B.	 1.	 To change the outline colour of the shape, follow these steps:
	 	 Step 1	 Click on the shape to select it. Click on the Format tab.
		  Step 2	� Click on the Shape Outline command in the Shape Styles group to change outline 

colour. A Colours palette opens.
		  Step 3	 Choose and click on a colour.

	 2.	� WordArt is a collection of text styles that adds decorative effects to your documents. WordArt 
allows you to create text effects that are not possible through text formatting. To apply 
WordArt effect to text, follow these steps:

		  Step 1	 Click on Insert tab.
		  Step 2	� Click on WordArt command in the Text group. 
		  A drop-down menu appears with different types of WordArt styles.
		  Step 3	 Select the desired style. A textbox will appear in the document.
		  Step 4	� Enter text in the textbox. After entering the text, click anywhere outside the text box. 

The text entered appears in the selected WordArt style.

	 3.	� We can insert a saved picture or a scanned photo in our document. To insert a picture, follow 
these steps:

		  Step 1	 Place the cursor where you want to insert the picture. Click on Insert tab.
		  Step 2	� Click on the Pictures command in the Illustrations group. Insert Picture dialog box 

appears.
		  Step 3	 Browse the location and select the desired picture.
	 	 Step 4	 Click on Insert button. The selected picture will be inserted in your document.

C.	 1.	 To change the colour of a shape, follow the given steps:
	 	 Step 1	 Click on the shape to select it. Click on the Format tab. 
	 	 Step 2	� Click on the Shape Fill command in the Shape Styles group to fill the shape. A Colours 

palette opens. 
	 	 Step 3	 Choose and click on a colour.  
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	 2.	 To insert a picture, Tara should follow these steps: 
	 	 Step 1	 Place the cursor where she wants to insert the picture. Click on Insert tab. 
	 	 Step 2	� Click on the Pictures command in the Illustrations group. Insert Picture dialog box 

appears. 
	 	 Step 3	 Browse the location and select the desired picture. 
	 	 Step 4	 Click on Insert button. 
	 	� The selected picture will be inserted in her document and appear at  the position of the 

cursor. 
Higher Order Thinking Skills (HOTS) 
	 1.	 To apply WordArt effect to text, follow these steps: 
	 	 Step 1	 Click on Insert tab. 
	 	 Step 2	� Click on WordArt command in the Text group. A drop-down menu appears with 

different types of WordArt styles. 
	 	 Step 3	 Select the desired style. A textbox will appear in the document. 
	 	 Step 4	� Enter text in the textbox. After entering the text, click anywhere on the document 

outside the text box. The text entered appears in the selected WordArt style. 
	 2.	 To insert a picture, follow these steps: 
	 	 Step 1	 Place the cursor where you want to insert the picture. Click on Insert tab. 
	 	 Step 2	� Click on the Pictures command in the Illustrations group. Insert Picture dialog box 

appears. 
	 	 Step 3	 Browse the location and select the desired picture. 
	 	 Step 4	 Click on Insert button. The selected picture will be inserted in the document. 

Crack CodeThe

A.	

      
B.	 1   Click on the Format tab.

	 3   �Hover the mouse over the 3-D Rotation option from the drop-down menu.

	 4 	 Select the desired rotation effect from the submenu.

	 2 	 Click on the Shape Effects from the Shape Styles group.
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Do it yourself.

Worksheet–1
(Based on chapters 1 to 4)

A.	

General Purpose Software

Spreadsheets Image Processing 
Software

Application Software

Customised Software

Word Processors Presentation 
Software

Desktop Publishing 
Software

Multimedia 
Processors

Database Management 
Systems

B.	 1. Ctrl + F		  2. Ctrl + H		  3. Ctrl + Shift + =	 4. Ctrl + Shift + Enter
C.	 1. Insert		  2. Page Margin

	 3. Booting	 4. Lady Ada Lovelace

D.	 1. �In 1944, Prof. Howard Aikens built the first electro-mechanical powered computer named 
Mark-I.

	 2. �A computer provides a high degree of accuracy. Every calculation is performed with the same 
accuracy.

	 3. The WordArt gallery contains different types text styles to create text effects.

Test Sheet–1
(Based on chapters 1 to 4)

Section A
A.	 1. c	 2. b	 3. a
B.	 1. F	 2. F	 3. F
C.	 1. Subscript	 2. Lady Ada Lovelace	 3. Disk defragmenter
Section B
A.	 1.	 Fourth Generation computers used microprocessors.
	 2.	 Multimedia Software is used to combine the text with graphics, videos and sounds.
	 3.	 Page margin is the white space all around the printed area of the paper.
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B.	 1.	� WordArt is a collection of text styles that adds decorative effects to your documents. WordArt 
allows you to create text effects that are not possible through text formatting. To apply 
WordArt effect to text, follow these steps:

	   Step 1	 Click on Insert tab.
	   Step 2	� Click on WordArt command in the Text group. A drop-down menu appears with 

different types of WordArt styles.
	   Step 3	� Select the desired style. A textbox will appear in the document.
	   Step 4	� Enter text in the textbox. After entering the text, click anywhere on the document 

outside the text box. The text entered appears in the selected WordArt style.
	 2.	 The two features of fifth-generation computers are:
	 	 (i) Use artificial intelligence. 
	 	 (ii) Improved size, cost, speed and performance.
	 3. �System software is the most important software to operate a computer. System software 

can be classified into three categories: Operating System, Programming Software and Utility 
Software.

 Presentation Software—Special Effects

OneOne LearnTouch

A.	 1. b.		  2. c.		  3. c.		  4. c.

B.	 1. Placeholder	 2. Design		  3. Format		  4. Justify
C.	 1. d			   2. c		  3. b		  4. a

ItLet's Do

A.	 1.	� A placeholder is a box in PowerPoint that contains dotted lines and are used to insert images, 
text, shapes, etc.

	 2.	� PowerPoint templates are well-developed presentations. We only need to change the text 
and our presentation is ready.

	 3.	� The four types of alignment are Align Left, Align Right, Center and Justify.
B.	 1.	 To insert Online pictures in the document, follow these steps:
		  Step 1	 Place the cursor where you want to insert the picture. Click on Insert tab.
		  Step 2	� Click on Online Pictures command in the Illustration group. An Online Pictures dialog 

box appears. 
		  Step 3	� Type in the Bing image search text box and press the Enter key. Select a picture.
	 	 Step 4	� Click on the Insert button. The selected picture will be inserted into your document. 

5.
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	 2.	 To insert shapes on the slide, follow these steps:
		  Step 1	 Click on Insert tab.
		  Step 2	 Click on Shapes command in the Illustration group.
		  Step 3	� Choose a desired shape from the drop down menu. The desired shape will be inserted 

into the slide.
	 3.	� Just as you were able to change the background of a plain PowerPoint slide, you can do 

the same while using one of the many themes. You can also customize the background of 
individual slides. To add WordArt to a slide, follow these steps:

		  Step 1	 Click on Insert tab.
		  Step 2	 Click on WordArt command in the Text group.
		  Step 3	 Select the desired style. A textbox will appear in the slide.
		  Step 4	� Enter text in the textbox. After entering the text, click anywhere on the slide outside 

the text box.
C.	 1.	� Rohin can use the Pictures or Online Pictures commands present in Illustration group under 

the Insert tab to achieve this.
	 2.	� Sunita can find the ready made templates under the New option in the File tab to make her 

slide look more colourful and attractive.
Higher Order Thinking Skills (HOTS) 

	 1.	� The ready made templates can be used in this situation. You can use them by following the 
given steps: 

		  Step 1	 Click the File tab. 
		  Step 2	 Click on the New option. 
		  Step 3	 You will see a list of ready made templates. Choose a template. 
		  Step 4	 Click on Create button.
		  You will see a presentation with many slides already formatted.  
	 2.	 Luke can use Online Pictures command to achieve this.

Crack CodeThe
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Do it yourself.

 An Introduction to Scratch Programming

OneOne LearnTouch

A.	 1. a.	 2. b.	 3. a.	 4. c.	 5. c.

B.	 1. F		  2. F	 3. T	 4. T
C.	 1. Backdrop	 2. Stage	 3. Brown	 4. Blocks

ItLet's Do

A.	 1.	 Features of Scratch:
		  (i)	 Easy to understand and learn.
		  (ii)	 It has tools for creating interactive stories and games.
	 2.	 Sprite is an object that we see on the Scratch stage. The ‘Cat‘ is the default sprite.
	 3.	 Events blocks are used to sense events.
	 4.	 A backdrop is a background of the stage.

B.	 1.	
Low Level Language (LLL) High Level Language (HLL)

A Low Level Language (LLL) is a 
programming language that is machine 
dependent. A machine dependent 
language runs only on one particular 
type of computer.

High Level Language (HLL) is a programming 
language that enables a programmer to write 
programs that are machine independent. The 
main advantages of high level languages over 
low level languages is that they are easier to 
read, write and maintain.

	 2.	� Sound blocks are used to control sounds. These blocks control the playback and volume of 
the sound files selected by you. “play sound meow” block is an example of Sound blocks.

	 3.	� Motion Blocks are used to control the sprite movement. When you click on the Motion button, 
you will see the programming blocks that can be used with the sprite for its placement, 
direction, rotation and movement.

	 4.	 To save a project, follow these steps:
		  Step 1	 Click on the File menu.
		  Step 2	 Click on ‘Save to your computer’ option. 
		  Step 3	 Choose the location where you want to save the project. 

6.
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		  Step 4	 Type the name of project in ‘File Name’ box. 
	 	 Step 5	 Click on Save button.
C.	 1.	� Nitin should use ‘Move () steps’ block from the Motion blocks category to make the cat move.

	 2.	� To do so use ‘when this sprite clicked’ block from Events blocks and ‘play sound () until done’ 
block from the Sound block category.

Higher Order Thinking Skills (HOTS) 

1.	 Low Level Language (LLL) High Level Language (HLL)
A Low Level Language (LLL) is a 
programming language that is machine 
dependent. A machine dependent 
language runs only on one particular 
type of computer.

High Level Language (HLL) is a programming 
language that enables a programmer to write 
programs that are machine independent. The 
main advantages of high level languages over 
low level languages is that they are easier to read, 
write and maintain.

2.	� A program is a set of instructions given to the CPU in a proper sequence to complete a task. 
Programs are written in a computer language with a pre-defined Syntax. 

Crack CodeThe

1.	 Stage		 2. Size	 3. Green Flag	 4. Stop button	 5. Block

Do it yourself.

 Internet Services

OneOne LearnTouch

A.	 1. a.		  2. b.		  3. b.		  4. b.

B.	 1. F		  2. T		  3. T		  4. F		  5. F

C.	 1. Facebook	 2. Dial-up	 3. Online shopping

	 4. Wi-Fi		  5. Internal Modem

ItLet's Do

A.	 1.	� Modem stands for Modulator Demodulator. It is generally used when users want to access 
Internet service provided by the Internet Service Provider (ISP) through their telephone line.

7.
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	 2.	� Online shopping allows us to buy various products such as grocery items, clothes, electronic 
gadgets, books, etc. We need not to leave our home for shopping. We can buy from our 
home through Online shopping websites. 

	 3.	� Online chatting allows us to interact with other people through Online chatting apps. It can 
be accessed to meet new people and make friends.

	 4.	 Facebook, Instagram and X are social networking websites.

B.	 1.	 Wi-Fi is one of the numerous ways to connect your computer to the Internet.
	 	 Difference between Wi-Fi and broadband:
	 	 Wi-Fi Broadband

a. � Wi-Fi uses radio frequency to connect 
to the Internet. Wireless connections 
are possible through the modem, 
which picks up Internet signals and 
sends them to computers.

a. � Broadband is provided through either cable 
or telephone companies. It is significantly 
faster than a dial-up connection and makes 
or receives phone calls.

b. � Wi-Fi does not require cable to 
provide Internet access.

b. � A broadband connection provides Internet 
access only through cable.

	 2.	� In Online communication, you may not be face to face with the person. There may be a situation 
when the person may misunderstand your remark. In order to avoid misunderstanding, a set of 
rules have been designed which are expected to be followed during Online conversation. This 
set of rules are  known as Netiquettes. It basically stands for Network Etiquettes. Netiquette, 
or “internet etiquette”, is a set of guidelines for polite and considerate behaviour when using 
online technology.

	 3.	� E-mail stands for Electronic Mail. It allows us to send or receive electronic messages which 
can be text, picture and sound. With e-mail, we can communicate quickly and easily with 
millions of people across the world. It is an essential tool for business. It is also excellent for 
keeping in touch with family and friends.

C.	 1.	 Online shopping is the best online service to use in  this situation.
	 2.	 Wi-Fi is wireless networking technology that uses radio waves to connect to the Internet. 
Higher Order Thinking Skills (HOTS) 
	 1.	 I will use Video conferencing app like Zoom or Skype to do so. 
	 2.	 Instagram is an example of Social networking website.

Crack CodeThe

	 1. ISP			   2. Wi-Fi			  3. Social Networking Website

	 4. Search Engines		  5. Hotspot
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Do it yourself.

Worksheet-2
(Based on chapters 5 to 7)

A.	

Tabs

Menu Bar

Script
Sprite

Sprites Info Pane

Stage

Block 
Palette

Go Button Stop Button

Backdrop

Coding Area

B.	 1. WHATSAPP	 2. NETIQUETTES	 3. ALIGNMENT
	 4. MODEM		 5. PRESENTATION
C.	 1. c			   2. d		  3. b		  4. a

Test Sheet–2
(Based on chapters 5 to 7)

Section A
A.	 1. c (File)		  2. (i)	 3. (iii)
B.	 1. F			   2. F	 3. F
C.	 1. Wi-Fi		  2. Stage	 3. Place holder

Section-B

A.	 1.	 There are four types of alignments in PowerPoint - Align Left, Align Right, Center and Justify. 
	 2.	 Events blocks are used to sense events which run the scripts.
	 3.	 1. Facebook	 2. Instagram	 3. X
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B.	 1. �Just as you were able to change the background of a plain PowerPoint slide, you can do 
the same while using one of the many themes. You can also customize the background of 
individual slides. 

	 2.	 To insert a WordArt on the slide, follow these steps:
	 	 Step 1	 Click on Insert tab.
	 	 Step 2	 Click on WordArt command in the Text group.
	 	 Step 3	 Select the desired style. A textbox will appear in the slide.
	 	 Step 4	� Enter text in the textbox. After entering the text, click anywhere on the slide outside 

the text box.
	 3. a. �E-mail stands for Electronic Mail. It allows us to send or receive electronic messages which 

can be text, picture and sound. With e-mail, we can communicate quickly and easily with 
millions of people across the world.

	   b. �Dial-up requires users to link their phone line to a computer in order to access the Internet. 
It doesn’t allow users to make or receive phone calls through phone service while using the 
Internet.


